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Introduction - How to Use this Book

When I was asked to write this book I was delighted. It brings together two subjects about 
which I am passionate-garden and landscape design—and Vectorworks Landmark.

The book has been designed as a workbook that covers the typical work stages of the 
Landscape Garden Designer. You will start with setting up your environment, then move 
through the various stages of the design process in order to create a garden which is both 2D 
and 3D.

It is not designed to make you a complete expert in Vectorworks. It is designed to build a 
foundation of essential knowledge to help you understand the way Vectorworks is intended to 
work within your design discipline. It complements the information provided in the free guides 
discussed below, and the extensive Help system which is installed on your machine with the 
software.

You will need Vectorworks Landmark 2009 software and Renderworks is recommended in 
6$>#$1*6143&/1*)#1D3"&D7D1E#/#=*1F$6D1*)#196$GE66G13/>1&/>##>1H#%*6$96$G'I

Before you Start

This book builds on the basic skills covered in the two free guides that cover the basics of 
>$39&/41&/1E6*)1J<13/>1K<I1L*1&'1$#%6DD#/>#>1*)3*1+6717'#1*)#'#147&>#'1=$'*I1()#+1%3/1E#1
downloaded from:

http://www.nemetschek.net/training/free_resource.php

M1 QuickStart to Landmark

M1 Getting Started with Vectorworks Landmark 2009

In addition, if you are completely new to using a computer, it would be really useful if had a 
basic understanding of the following:

M1 N691=;#'13/>1F6;>#$'13$#16$43/&O#>16/131%6D@7*#$

M1 N691*616@#/1=;#'

M1 N691*61'3.#1=;#'

This information is available on the Microsoft and Apple Web sites, so if you’re completely new 
to using a computer, I recommend you look at some of their free training videos.
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How to Use this Manual

This manual comes as a hard printed copy with one CD-ROM. The CD contains an exercise 
F6;>#$1%3;;#>1PQ3/>D3$G1JRRS1!"#$%&'#'TI126@+1*)#1#"#$%&'#1F6;>#$1*6131=;#1;6%3*&6/16F1+67$1
%)6&%#16/1+67$1%6D@7*#$1'7%)13'1PU+1<6%7D#/*'T1*61D3G#1&*1#3'+1*61=/>1*)#1=;#'I1-3.#13/+1
*$3&/&/41=;#'1+67196$G16/1*61+67$1#"#$%&'#1F6;>#$I

I recommend that to start with, you work through the book from end to end, using the 
examples on the accompanying CD. You may look at a subject and think you are already 
using those tools, but it’s always worth working through as you may still learn something. 
Vectorworks is huge so you can learn something new all the time.

I have written the workbook in such a way that once you’ve mastered the basics, you can dip 
in and out of the book as needed and keep it by you as a handy reference.  Some chapters 
will be essential to learn before you can go further—like the basics of setting up your drawing 
board and Resource Browser. But after that, if you want to remind yourself about the hard 
landscaping you can just go straight to that section. At each stage, I’ve provided a completed 
'3D@;#1=;#19&*)1*)#1%)3@*#$V1'61*)3*1+671%3/1%6D@3$#1+67$1$#'7;*'19&*)1D&/#I1()#$#F6$#1+671
%3/1@&%G17@1*)#1E66G13/>1'*3$*13*13/+1@;3%#1E+16@#/&/41*)#1%6D@;#*#>1=;#1F6$1*)#1@$#.&67'1
chapter.

Vectorworks Environment Used in this Book

The book covers both the PC running Windows and the Apple Mac running MacOS. However, 
the exercises and screenshots have been developed on a PC environment, with Windows XP 
as the operating system. Where instructions for each environment differ, I have noted this with 
the use of the following text:

M1 Apple

M1 PC

Having installed Vectorworks, you should start with the guides that were delivered with your 
software, as they will take you through the basics of drawing and give you some familiarity 
with the environment. This book is not intended to replace the extensive Help system that 
&/'*3;;'19&*)1*)#1'6F*93$#I1W)&;#1&*1>6#'1/6*1%6.#$1&/>7'*$+196$GX69'V1*)#1N#;@19&;;14&.#1+671
in–depth supplementary information on the tools you will use in this book. With Vectorworks, 
there are always many ways to achieve something and whichever way works best for you is 
the one to stick with.

The book is based on Vectorworks 2009 Landmark with Renderworks and includes exercise 
=;#'1&/1*)#1H#%*6$96$G'1JRRS1F6$D3*I1()#$#F6$#V1+6719&;;1/##>131%6@+16F1*)#1'6F*93$#1&/16$>#$1
to use it. This could be a demonstration copy, an Educational License or a Full License. Some 
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of the exercises require Renderworks also. If you don’t have Renderworks it won’t stop you 
using this book but it you won’t be able to complete some of the exercises and achieve the 
'3D#1=/&')#>1;66G1&/1'6D#1%3'#'I

Typing Conventions in this Book

Exercises are clearly noted and their instructions are shown as follows:

1. This is step one of this exercise.

Wherever menus and tools are discussed in this book, their names are written exactly as you 
9&;;1=/>1*)#D1&/1*)#13@@;&%3*&6/I1()#1;6%3*&6/16F1#3%)1*66;1&'1>#'%$&E#>1&/1*)#1&/'*$7%*&6/I1(66;'1
can display their names in their respective palettes or can display their name when you hover 
the mouse over them. An example is as follows:

2. Use the Circle tool found in the Basic palette. Change the mode of the Circle tool to Circle 
By Diameter Mode using the Tool bar.

Exercises may also contain lists of instructions within one numbered step. These are shown 
as a bulleted list. In the example below you should type the value 1000 in Box A:

M1 Box A: 1000

M1 Box B: 2000

W)#$#.#$1L1$#F#$1*61'@#%&=%1G#+'16/1*)#1G#+E63$>V1LY.#17'#>1%3@&*3;1;#**#$'1*61>&'*&/47&')1*)#1
key from Vectorworks menus and tools. For example:

3. To constrain the line to a 45° angle, hold down the SHIFT key while drawing.

4. -3.#1*)#1=;#17'&/412(ZQ[  +S

Regional Variations – Language and Measurements

Despite being born and bred in the UK, I have done by best to write this book in American 
English to reach that wider audience! For example, here in the UK, we have spanners, 
whereas in the US there is no such thing as a spanner, but there is a wrench instead.

The book also covers both metric and imperial measurements. My primary measurements are 
in millimeters or meters, but I have also translated into imperial. Sometimes these 
measurements are an exact translation whereas sometimes they are a more sensible 
translation. For example:
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500mm has been translated as 1’6” whilst the exact translation would be 1’ 7 5/8”. In this 
book, this is written as follows:

1. Draw an object with the following dimensions:

M1 Width: 500mm (1’6”)

 When I am training new users, there is often much discussion as to why some use metric and 
some use imperial. A recent discussion with other Vectorworks users made it clear to me that 
the two systems are widely used in many cultures. For example, here in the UK, we draw in 
millimeters or meters, buy paving by the square meter, but buy timber with imperial 
>&D#/'&6/'I1W#13;'61D#3'7$#1$3&/F3;;1&/1&/%)#'13/>1=;;167$1%3$'19&*)1;&*#$'16F1F7#;I1B7*19#1
measure the consumption of fuel in miles per gallon. At the end of the working day we may go 
to the pub for a quick pint of beer! So, tolerance and the ability to convert is crucial.

Approximate Metric to Imperial Conversion

L/1*)#1*3E;#1E#;69V1+6719&;;1=/>1'6D#1%6DD6/1D#*$&%1*61&D@#$&3;1%6/.#$'&6/'1\1*)#+13$#1
approximate and make the most sensible translation.

Metric Imperial

25 mm 1”

100 mm 4”

150mm 6”

0.3m 1’

0.5m 1’6”

1.5 m 5’

1.8m 6’

3m 10’

10m 33’
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English / American Phrase Book

In putting together this book, I have also discovered the joys of a common and yet very 
different language! This table includes some of the words I use in my English-English and how 
they translate to American-English!

English American

Spanner Wrench

Label (341]3;'61D#3/'14$3F=*&1&/1A$3/%#^

Biscuit Cookie

Maths Math

Windows vs. Mac

The Vectorworks software generally behaves identically on the Mac as it does on the Windows 
environment. However, there are certain differences on the keyboard which are noted here.

Windows key Equivalent Mac Key

Control (or Ctrl) Command (or )

Delete Some Mac keyboards don’t have a delete key and use the 
B3%G'@3%#1G#+1&/'*#3>1]_^

Sometimes, I’ve suggested keystrokes that can be used as shortcuts. For example, the 
26/*$6;1G#+1)#;>1>69/19&*)1*)#1-1G#+1%3/1E#17'#>1*61'3.#131=;#19&*)67*1)3.&/41*61461*61*)#1
A&;#1D#/7I1W)#$#1LY.#19$&**#/1'7%)1')6$*%7*'V1LY.#1')69/1W&/>69'1=$'*13/>1*)#/1*)#1U3%1
equivalent as follows:

1. -3.#1+67$1=;#17'&/41A&;#[-3.#16$1E+17'&/412(ZQ`-[ +S on your keyboard.

Now it’s time to get started!
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Setting up the Drawing Board

By the end of this chapter, you will have an understanding of how to set up your Vectorworks 
drawing area so that it’s ready for you to work in the way that’s best for you each time you 
start a new project. If you’re making the transition from hand-drawing to working on a 
computer, you can liken this process to that of setting up your drawing board. If you were 
drawing by hand, you would start by choosing the size of paper you wish to work on, and then 
select an appropriate scale for your drawing and so on. We will do the same here. Once 
you’ve set up your most common ways of working, you’ll be able to save them so that you 
don’t need to repeat the setup each time you work.
There are many options for setting up the system and some of them may appear meaningless 
to you. Remember that Vectorworks is an extremely powerful tool that covers many different 
design disciplines. If those settings aren’t appropriate to garden design, we won’t cover them 
so you can be assured that we’ll be focusing only on the things you need.
Some of the things I’m going to take you through in this chapter may not make complete 
sense to you yet. For example, you may still be feeling a little unsure about the concept of 
classes and layers. Don’t worry, it will all become clearer as you work through the book. At this 
stage, we are ensuring that we have the system setup in a way that will work well for you.

About the Different File Types Vectorworks Creates
H#%*6$96$G'1=;#'1)3.#131I.9"1=;#1#"*#/'&6/13/>13$#1'3.#>1&/1*)#1>&$#%*6$+1+671>#'&4/3*#1,1F6$1
example c:\Documents\ClientA\ClientA.vwx.
H#%*6$96$G'1E3%G7@1=;#'V1%$#3*#>1E+1*)#137*6D3*&%1E3%G7@1F3%&;&*+19#Y;;1'#*17@1;3*#$1&/1*)&'1
chapter, have a .vwx extension too.
H#%*6$96$G'1*#D@;3*#1=;#'1)3.#131I'*31=;#1#"*#/'&6/I1?1*#D@;3*#1&'131=;#1*)3*1%6/*3&/'13;;1*)#1
*)&/4'1+67193/*1*61&/%;7>#1&/1#.#$+1=;#I1W#19&;;1%$#3*#131*#D@;3*#13*1*)#1#/>16F1*)&'1%)3@*#$I1
You can create as many templates as you like in order to cater to different working scenarios.

The Landmark Workspace “Drawing Board”
The workspace contains the “drawing board” together with all the drawing tools and menus 
you need arranged around it. You can’t drop the tools off the edge of your board and the ink 
doesn’t dry up either! Some of these tools are arranged on palettes and some are arranged on 
menus. The diagram below shows the Landmark layout and the main items you will use to 
%$#3*#1+67$1>$39&/4'I1()#1*#$D1P96$G'@3%#T1D#3/'131/3D#>1>#=/&*&6/16F1*)#193+1*)#1*66;'1
and menus are laid out for you. Throughout this workbook, we’re going to use the Landmark 
W6$G'@3%#I1?'1+671E#%6D#1D6$#1@$6=%&#/*19&*)1*)#1'+'*#D1+671%3/V1&F1+6719&')V1#>&*1*)#1
workspace or even create your own—if you’ve been used to using another system you may 
wish to customise the workspace to make it more familiar. At this stage, though, I suggest you 
learn the Landmark Workspace as it is.
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If you’re using Windows, the “palettes” containing tools and utilities can be “docked”. This 
means that they are “stuck” to the side of the screen and do not overlap the drawing area. If 
you’re new to drawing on a computer, it’s easy to unwittingly remove palettes from the dock or 
close them completely. If you have “undocked” them and want to move them back to their 
home, you can click and drag their heading onto the heading of another palette which will lock 
*)#D1E3%G1&/*61@6'&*&6/I1?;*#$/3*&.#;+V1+671%3/1)3.#13;;1+67$1@3;#**#'1PX63*&/4T1'61*)3*1*)#+1
move independently. They can also be set to roll up completely so that they only open when 
you place the mouse pointer on them. On the top right of the palette, you’ll see a little icon that 
looks like a map-pin. Click on this to “unpin” the palette. It will close when you move the 
mouse away from it.
On a Mac, the palettes can’t be docked and always move as independent windows—this is 
not a Vectorworks design issue but, rather, the way the Mac operating system works.
Palettes can also be closed by clicking on the small x on the top right (Windows) or the red 
button at the top left (Mac). If you close a palette by accident, it can be opened using the 
Windows / Palettes menu.
Along the top of the screen, just below the menu, is an area known as the View bar. You can 
change which buttons are displayed on this. If you are using a mouse I recommend that you 
remove the zoom options as you can zoom with your mouse.

Exercise One: Ensure you are Working in the Landmark Workspace
1. From the Tools menu, choose Workspaces, then select Landmark from the list.
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2. The windows and palettes on your screen 
will disappear temporarily as the 
workspace re-starts, but don’t panic—they 
will all re-appear.

3. If you’re using Windows on a PC, click on 
the heading of the palette named Object 
Info and drag it. Notice that it’s become a 
X63*&/41@3;#**#I

4. Click on the map-pin icon on the top right 
of the palette and click on a blank space 
on the drawing. Notice that the palette 
closes, leaving just its heading visible.

5. Roll your mouse over the palette again 
and notice it opens. Click on the map-pin 
again to pin the palette open.

6. Drag the heading of the palette over the heading of the Navigation palette (still docked). 
Notice that the Object Info palette is now docked again.

7. Notice the scroll bar on the right of the Resource Browser palette. Use your mouse to 
move the slider up and down to reveal more information on the palette.

8. Now we’ll change the view bar to show the 
layer scale button instead of the Zoom 
buttons - if you are using a mouse you 
won’t need the zoom. Click on the arrow 
at the top right of the screen. This will drop 
down a menu. Click next to Zoom to 
remove it. Click next to Layer Scale to add 
it. This makes better use of the space and 
gives you a shortcut to changing your 
layer scale.

Exercise Two: Set Up Your Vectorworks Preferences
Changes made to Vectorworks Preferences will affect the way Vectorworks runs each time it 
is started on your computer. The changes are not limited to the current drawing but apply each 
time you open the program. I’m going to take you through my recommended settings but I’m 
not going to go into huge detail here about what each means – the Help system is really good 
for that. My aim is to give you a setup that will get you up and running in a sensible way, as 
quickly as possible. Note that you can also hover your mouse over each of the options to get a 
description of what the option does.
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4   Residential Garden Design with Vectorworks Landmark © Nemetschek North America and Tamsin Slatter

1. From the Tools menu, choose Options, then Vectorworks Preferences.
2. Work through each of the tabs, making selections as I recommend below:

Edit Tab
1. Ensure the following boxes are checked:
M1 Eight reshape handles
M1 Offset duplications
M1 Auto join walls
M1 Mouse wheel Zooms

2. Set 2D conversion res to Very High
3. Leave Default compression to PNG
4. Set Nudge objects to Arrow, so that when 

you select objects, you can use the arrow 
keys to move them very precisely, one 
pixel at a time.

!"#$%&'(&)"*+,$&*-$.&"#/$0&.012345&617815$-9&)"*&:1)&;4.&#/1#&<=378&>015&.012345&3-&:"0$&
(1:3=310&#"&)"*&#/14&#/$&.$(1*=#&<=378?<=378&-#)=$&"(&.012345@&A/3-&-$##345&3-&1=-"&B$-#&3(&)"*&
10$&2"08345&23#/&1&#1B=$#&34-#$1.&"(&1&:"*-$@&C"2$,$09&'&0$7"::$4.&)"*&-#378&#"&<=378?
<=378&2/3=$&*-345&#/3-&2"08B""8@

Display Tab
1. These preferences affect the way things are displayed and are mostly self-explanatory. 

Ensure the following are checked:
M1 Rulers
M1 Scroll Bars (only if you don’t have a 

mouse with a wheel)
M1 ?>a7'*1X&@@#>1(#"*
M1 Show parametric constraints
M1 Show other objects while in editing 

modes along with Gray other objects
M1 Use VectorCaching for faster drawing
M1 Center on objects after view change
M1 GDI+ imaging (Quartz imaging on a 

Mac) and Anti-aliasing
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M1 Display light objects: Only in wireframe
M1 Display 3D loci: Only in wireframe

2. Click on the Font Mapping table as this will allow you to decide what happens to fonts 
&/%;7>#>1&/1=;#'1*)3*1+671&D@6$*1F$6D16*)#$1'67$%#'I1LF1+671>61/6*1)3.#1*)#1'3D#1F6/*'1
installed, you may want Vectorworks to automatically convert the fonts to your own “house” 
font.

Session Tab
1. In this tab, I would certainly recommend that you switch off sound—otherwise you get an 

irritating click every time you move the cursor across your screen. If you’re working in an 
6F=%#19&*)16*)#$1@#6@;#V1&*1%3/1@7*131)74#1'*$3&/16/1F$&#/>')&@'b1:$#F#$#/%#'1L1$#%6DD#/>1
turning on are:
M1 Log time in program
M1 Display minor alerts on message bar
M1 Maximum number of undos: 20
M1 Issue undo warnings
M1 Undo view changes: Never (unless you 

want each view change to be 
considered an “action” by 
Vectorworks).

M1 Enable palette docking (Windows only)
M1 Display default content
M1 Automatically check for updates: Weekly

3D Tab
These preferences describe how Vectorworks 
will handle the display of 3D objects.
1. If memory and processing power is not a 

problem, set the following:
M1 3D rotation to Responsive and Retain 

Rendering Model to Always.
M1 Switch on 3D axis labels, as they will 

help with orientation when you are 
working in 3D.

LandmarkWorkbookTamsinSlatter.indb   5 30/01/2009   11:02:08

Sample



6   Residential Garden Design with Vectorworks Landmark © Nemetschek North America and Tamsin Slatter

Autosave Tab
This tab is incredibly important! If you’re moving from hand-drawing, your common fears were 
probably spilling coffee on your drawing or the cat walking across it. Now, you are going to be 
relying on your computer for the delivery of projects, and computers can fail sometimes. You 
/##>1*61E#1'7$#1*)3*1+67$1@$6a#%*1=;#'13$#1E3%G#>17@I1H#%*6$96$G'1%3/1)3/>;#1*)&'1
automatically for you. The settings I recommend are:
1. Set Autosave every 5 minutes (or less).
2. -9&*%)18AA126/=$D1E#F6$#1'3.#1'61*)3*1

you don’t have to keep responding to 
prompts on the screen.

3. Save to a backup folder in the same 
;6%3*&6/13'1*)#16$&4&/3;1=;#I1()&'1D#3/'1
you will be responsible for manually 
'3.&/41*)#1D3&/1=;#V1E7*1+6719&;;1)3.#131
backup automatically saved. You will use 
twice the disk space, but disk space is 
cheap compared to the cost of a lost 
project.

4. Your alternative is to back up to a custom location, such as a separate backup folder where 
+671G##@13;;1+67$1E3%G#>,7@1=;#'I1L*Y'1D6$#1#FF6$*1*61=/>1*)#DV1E7*1%67;>1D3G#1&*1#3'&#$1*61
G##@13/16FX&/#1E3%G7@1]6/*613/1#"*#$/3;1'*6$34#1>#.&%#^I

Interactive Tab
This tab allows you to control what the cursor on the screen shows you. The 2009 cursor 
offers many helpful hints on the screen, making it easy to select drawn objects, line objects up 
with others, and much more. There are further settings that work in conjunction with these.

1. Set your preferences as follows:
2. Click on the Interactive Appearance 

Settings button to view the colors of the 
information on the screen. For now, I 
suggest you leave them as they are until 
you’re familiar with their meaning, but 
remember that you can change them later 
if you wish.

User Folders
This contains the default location on the disk 
where Vectorworks will store the preferences you are setting, along with any templates you 
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create. Generally, there is no need to change this at all unless you particularly want them 
'*6$#>1#;'#9)#$#I1()&'1F6;>#$1;6%3*&6/13;'61'*6$#'1=;#'1'7%)13'1*)#1H#%*6$96$G'1;6419)&%)1
')69'19)&%)1=;#'1+6716@#/#>13/>19)#/c.#$+17'#F7;1F6$1E&;;&/41+67$1%;&#/*'b15671%3/1E$69'#1
this folder by clicking on the Browse button.

Exercise Three: Managing Other Vectorworks Settings
Constraints Palette
The Constraints palette helps you to draw more accurately and “constraint” drawn objects to 
certain parameters—such as forcing lines to be horizontal, at 45°, etc. It also ensures that 
helpful hints are displayed on the screen to ensure you have selected the correct point. 
1. Double-click on any one of the buttons on the Constraints palette and then review the 

menu items. We will be changing various items as we move through the book, so for now, 
just get familiar with accessing the menu, and then leave the palette looking like this:

2. To switch buttons on, click on them. A 
border will appear around the button when 
it is switched on. Click on it again to switch 
&*16FFI1()#1=$'*1=.#1E7**6/'19&;;1E#1
E#/#=%&3;19)#/1+6713$#1>$39&/4I1()#1;3'*1
three will only be switched on when you 
'@#%&=%3;;+1/##>1*)#DI

!"#$%&D)&.$(1*=#9&#/$&<"4-#0134#-&61=$##$&3-&
E"1#345@&'(&)"*&10$&2"08345&"4&1&F<9&)"*&
714&."78&#/$&<"4-#0134#-&61=$##$&3(&)"*&
wish by dragging its heading to the top or the left of your main application window.

Color Palette Libraries
L1*)&/G16/#16F1*)#1'*$6/4#'*1%$&*&%&'D'16F12?<1&/14#/#$3;1&'1*)3*1*)#1%6;6$'13@@#3$1X3*13/>1
limited and cannot replace the beauty of hand-drawing. If you spend some time getting to 
know the color palette options and later the gradient, hatch and stipple tools, you will be able 
to create very artistic effects. For now, we’ll look at the color palette and make some of the 
libraries available. The color palette allows you to select any color you like – but you can also 
'#;#%*1F$6D1'@#%&=%1@7E;&')#>1%6;6$1;&E$3$&#'1'7%)13'1:?d(8d!1eI
1. On the Attributes Palette, click on the white bar which displays Solid Fill Color.
2. Click on the Color Palette manager (spanner/wrench and pencil button) on the top right.
3. Select other color libraries you would like to make available in all your drawings by clicking 
&/1*)#1?%*&.#1%6;7D/1'61*)3*131%)#%G,D3$G13@@#3$'I1d6*#1*)3*1*)#$#13$#1:3/*6/#1e1;&E$3$&#'1
and other well-known libraries. Click OK.
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4. Click on the color bar again and note that 
the new libraries are now available for 
selection. These will now be available 
each time you use Vectorworks.

Exercise Four: Set Default Font
There is a range of text tools available within 
Vectorworks for adding annotations to your 
drawings. These will be covered in detail in a later chapter. However, for now we’re going to 
choose your favorite font to set it as the default font, so it’s used each time you add some text 
to the drawing. Of course, you can override the font settings for individual pieces of text.
1. On the Text menu, choose Format Text.
2. Choose your favorite font and the size at 

which you would like it to print. 
Vectorworks will remember this from one 
session to the next, so once set, it should 
stay set.

Document Preferences
Document preferences, unlike Vectorworks 
Preferences, are settings that are relevant to 
*)#1%7$$#/*1=;#16/;+I1()#'#1&/%;7>#1*)#1;3+#$1
scale; the units of measure for length, area, 
volume and angle; and the paper size. In 
order to make these settings available at the 
start of each new drawing, you will need to 
3D#/>1*)#D13/>1'3.#1*)#1E;3/G1=;#13'131
template. This is easily done with Save as Template command from the File menu.

Exercise Five: Set Up Your “Drawing Board” and Save Your Template
Open the Document Setup Dialog Box
()&'1>&3;641E6"1&'1F67/>1&/1<6%7D#/*1-#**&/4'17/>#$1*)#1=;#1D#/7I1L*13;;69'1+671*61'#*17@1*)#1
f/&*'16F1D#3'7$#D#/*1F6$1*)#1=;#V1*)#1'%3;#16F1*)#1=;#V1*)#1'&O#16F1*)#14$&>1,13/>19)#*)#$16$1/6*1
the grid is visible. You can also specify the default Drawing Border style and Title Block here, 
but you can also make changes to this later.
1. From the File menu, choose Documents Settings / Document Setup.
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Set Your Unit of Measure
The unit measurement is important because it determines the “real world” size of the objects 
you draw. It’s also critical when importing drawings from other CAD systems. Choosing the 
%6$$#%*17/&*16F1D#3'7$#1F6$1*)#1&/%6D&/41=;#1#/'7$#'1*)3*16Ea#%*'13$#1'&O#>1%6$$#%*;+19)#/1*)#+1
arrive in Vectorworks. When you set your units of measure, you also determine the number of 
decimal places that will be displayed (if any). For example, I suggest you display angles with a 
precision of 1 rather than 1.00. Your contractor may not appreciate being asked to set out the 
garden with angles of 45.32 degrees!
1. Within Document Setup, to the right of the Drawing Units setting, click on Change.
2. Choose the unit of measure you prefer to work in:
M1 If working in metric, I prefer mm for lengths, m2 for areas, m3 for volume and degrees 

for angles. Choose also the number of decimal places (precision) that you would like 
displayed for each of these values – (e.g., if you only want lengths displayed in whole 
mm, choose 1 in the Decimal Precision box).

M1 If working in imperial, you’ll probably want to choose feet and inches for length, square 
feet for area and cubic yards for volume. Choose Fractional precision for rounding and 
choose the size of the fractions for rounding (e.g., 1/8”). As with metric, choose the 
appropriate number of decimal places.

3. If using Decimal rounding (i.e., working in 
metric), you have the option to choose 
Leading and Trailing zeros for values (e.g. 
if an area measured 2 m2, this could be 
displayed as either 2 or 2.00 for 
consistency with other values on the 
drawing. I recommend you do this to avoid 
confusion. Similarly, a value of .25 m2 
would be displayed as 0.25 m2 to ensure 
that the decimal point is not missed when 
reading your plan).

4. Click OK, returning to the Document 
Setup dialog box.

Set Your Default Scale
1. To the right of the Layer Scale, click Change and set your default scale. You aren’t stuck 

with this scale, but it’s a good idea to choose the scale that you most commonly work in. 
You can always change it and you can view different elements of the garden at different 
scales anyway.

2. If you want to use a scale that is not listed in the boxes, you can enter your own custom 
scale in the Paper Scale box.
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M1 Metric users will probably use a scale of 1:100 or 1:50.
M1 Imperial users will probably be working at something like one quarter inch to a foot 

(1/4”=1’-0”) (1:48) or one–eighth–inch–to–the–foot (1/8”=1’-0”) (1:96).
3. The All Layers box is not ticked by default. 

Any new layers created in the drawing will 
use the scale you have set above. 
However, if you wish to change the scale 
of a drawing and it has many layers, you 
will need to tick this box so that your 
changes will affect all layers. Having said 
that, it’s possible to have many layers at 
different scales in the same drawing.

4. There is a scale text box that is ticked by 
default. This means that if you later 
%)3/4#1*)#1'%3;#16F1*)#1>$39&/41E#%37'#1+671$#3;&O#1*)#1'&*#196/Y*1=*16/1*)#1@34#V13/+1*#"*1
you have added will be scaled with the drawing. I recommend that you uncheck this box. 
Since you have chosen a default font and size for this font, you probably don’t want it to be 
rescaled and you want the text to remain the size you chose in the text setup.

5. Click OK, returning to the Document Setup window.

Set Your Drawing Area / Paper Size 
d6919#Y$#146&/41*61'#*1*)#1@3@#$1'&O#1F6$1*)#1>$39&/4I15671D3+1)3.#131@$&/*#$1&/1+67$16F=%#1
that can cope with the size of drawing you want to produce; in which case your computer will 
have a driver installed telling it all about the capabilities of your printer. However, many of us 
don’t have access to a large format printer and will be emailing our drawings to a print bureau. 
If this is your case, you need to choose the correct paper size before sending it. Vectorworks 
has options to cater to both these scenarios.
Also, you’ll use different paper size standards depending on where you are in the world so this 
exercise will cater for both imperial and metric standards.
1. On the Document Setup dialog box, next to Drawing Area, click Change.
2. LF1+671)3.#131;3$4#1F6$D3*1@$&/*#$13.3&;3E;#1&/1+67$16F=%#V13/>1&*'1>$&.#$1&'1&/'*3;;#>16/1+67$1

computer, click on Printer Setup to get to the printer’s own dialog box and choose the 
appropriate page size from there. Ensure that One Printer Page shows up in the box at the 
*6@1$&4)*16F1*)#1<$39&/41?$#31>&3;64I1()#1>&D#/'&6/'16F1*)#1@34#19&;;1$#X#%*1*)#1@$&/*3E;#1
3$#313'1>#=/#>1E+1+67$1@$&/*#$1>$&.#$I

3. LF1+6713$#1'#/>&/41+67$1=;#'1*6131E7$#37V1+6719&;;1/##>1*61%)66'#131@3@#$1'&O#1*)3*1+67$1
computer may not understand. For example, I have a printer that can print A4. Therefore, it 
can’t print and doesn’t understand A1. Click on Choose Size Unavailable in Printer Setup, 
and then select your desired paper size.

LandmarkWorkbookTamsinSlatter.indb   10 30/01/2009   11:02:09

Sample



Residential Garden Design with Vectorworks Landmark  11© Nemetschek North America and Tamsin Slatter

4. On the left of the dialog box, tick Show Page Boundary so that you will be able to see the 
edge of the page on your screen. Your drawing space is huge, but only things drawn within 
the paper area will print. Therefore it’s useful to see where that is!

5. Ensure that Show Page Breaks is 
unchecked. If you are using your own 
large format printer, and have set the 
paper size accordingly, page breaks won’t 
cause you a problem. However, if you 
have for example, an A4/letter size printer 
on your system but want to print at ISO A1 
(US Arch D) size, Vectorworks will 
helpfully show you where the page breaks 
would be for printing on the smaller 
printer. one of my most frequently asked 
questions is, “Where did this strange grid 
come from?”

6. Click OK to return to the Document Setup Window.

Set Up a Grid
Many designers choose to work with a visual grid to help them break up the space and ensure 
they are designing things that are a reasonable size. On a traditional drawing board, this might 
be a hand–drawn grid or sheet of graph paper stuck to the board under a piece of tracing 
paper. Vectorworks caters for this option, calling it a Reference Grid. Vectorworks also allows 
you to set a different type of grid, called a Snap Grid, which forces you to draw things to 
sensible dimensions. For example, I have set mine to 1mm meaning that if I draw something, 
its dimensions will only be in whole mm. An imperial equivalent might be 1/16”.
1. On the Document Setup dialog, click on Change to the right of Drawing Grids. This will 

open the Smart Cursor settings dialog box.
2. Click on Grid from the list on the left and then make the following changes:
M1 Set the snap grid to 1mm or 0.125 for 

1/16”.
M1 Change the reference grid to 2000mm 

(6’).
M1 If you regularly use a grid, check Show 

Grid Lines.
M1 If you don’t, ensure Show Grid Lines 

isn’t checked. You will have a grid 
available should you wish to view it 
later.
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3. Click OK and then Click OK again to return to the drawing.

Set Up Auto-classing
L1D#/*&6/#>1#3$;&#$1&/1*)&'1%)3@*#$1*)3*1+671D&4)*1/6*1+#*1E#1F##;&/41%6/=>#/*13E67*1%;3''#'I1
However, for now, take my word for it that they are going to make your life easier and 
Auto-classing is a really useful feature of the document setup. It instructs Vectorworks to 
automatically create certain classes (from a 
@$#>#=/#>1;&'*^19)#/1+671%$#3*#1%#$*3&/1
objects. This means you can be really 
organized without having to make the effort!
1. In File/Document Settings/Standard 

Naming, tick the Auto-classing box. You 
will see a message asking if you want to 
?7*6\%;3''1#"&'*&/416Ea#%*'1&/1*)#1=;#I12;&%G1
OK.

Set Up Dimension Preferences
15671%3/13;'61'#*131'@#%&=%1'*3/>3$>1F6$1*)#1
way dimensions appear – or you can create 
you own new one and edit it to your precise requirements.
1. From the File menu, select Document Settings then Document Preferences. Choose the 

Dimensions Tab.
2. Check all the boxes to ensure dimensions remain associated with the objects they are 

measuring. Then, if the objects change size, the dimensions will be updated with them.
3. Click the box to ensure that all dimensions 

are created in the Dimension class. This 
means you can control whether or not 
dimensions are visible later when you 
learn more about classes.

Save Your File as a Template
d691*)3*1+67Y.#1'#*17@1*)#1=;#13'1+671@$#F#$V1
+671%3/1D3G#1*)#1=;#13.3&;3E;#13'131*#D@;3*#1
so that you don’t need to go through the 
setup each time you start a new project. 
Clearly there is a lot more to learn about customizing Vectorworks than we’ve covered yet, but 
as we go through the course I’ll advise you to update your template when we learn something 
new that would be appropriate to save.
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1. From the File menu, choose Save as Template. Vectorworks will automatically place your 
=;#1&/1*)#1>&$#%*6$+19)#$#1&*1G##@'13;;1*)#1>#F37;*1*#D@;3*#'I1C&.#1+67$1*#D@;3*#131'#/'&E;#1
name such as “A1 1to100” (ARCHD 1 eighth= 1 foot), then click OK. You can’t use the :, “ 
6$1g1%)3$3%*#$'1&/1+67$1=;#/3D#I

Use Your Template When Starting a New Project
1. To make use of the template, choose File / New (or CTRL/  + N) and click on the Use 

Document Template button. Choose your template by name from the drop–down box.
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Adding Color and Pattern to Objects

W)#/1L1=$'*1'*3$*#>17'&/41H#%*6$96$G'V16/#16F1*)#1%$&*&%&'D'1L16F*#/1)#3$>1F$6D1*)6'#19)61
hadn’t yet made the leap to a computer aided design system, was that the colors were bland 
3/>1X3*I1N69#.#$V1L1'66/1>&'%6.#$#>1*)3*19&*)131;&**;#1#FF6$*1L1%67;>1%$#3*#1'6D#1;6.#;+1#FF#%*'1
that look hand–drawn. In this chapter, you’ll learn all about the graphic effects available for 2D 
objects. Once you’ve mastered these basics, you will be able to move on to some of the more 
specialized tools in Vectorworks Landmark, such as those for Hard Landscaping and Planting, 
both of which employ these graphic techniques and, in many cases, allow you to combine 
them to create more interesting effects.

The Attributes Palette
()#$#1&'131@3;#**#1X63*&/416/1+67$1'%$##/1%3;;#>1*)#1?**$&E7*#'1@3;#**#19)&%)1;66G'1;&G#1*)&'I
It allows you to set the default graphic 
qualities for 2D objects that you haven’t yet 
drawn. With the Attributes palette set as it is 
shown here (the default), I’ve drawn a circle 
that has adopted the attributes shown in the 
@3;#**#c31=;;16F1'6;&>19)&*#1%6;6$13/>13/1#>4#1
of solid back, with a pen thickness of 0.05 
mm. The opacity of the object is 100%. 
Opacity, being the opposite of transparency, 
means this object has no transparency and 
will completely cover anything it overlaps on 
your drawing—in this case, the drawing grid.
I’ve then selected the same circle and used 
*)#1?**$&E7*#'1@3;#**#1*61%)3/4#1*)#1=;;V1@#/1
and opacity of the circle. Instead of using a 
'6;&>1%6;6$V1*)#1%&$%;#1&'1/691=;;#>1E+131
gradient (a blend of two or more colors) and 
has a solid gray pen with a thickness of 0.25 
mm. Opacity has been reduced to 80% so the 
grid is partly visible behind the object. This 
will be very handy later when you add some 
trees to a design and want to be able to see 
through the canopy. 
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Exercise Six: Applying Graphic Attributes to 2D Objects

Setting basic attributes for an object is easy. The choices available on the Attribute palette 
initially are limited to what Vectorworks calls “Default Content,” a limited list, designed to get 
you started. Later, you’ll see how to extend this list using the extensive libraries that 
H#%*6$96$G'1)3'1&/'*3;;#>1F6$1+67I1567Y;;1a7'*1/##>1*61G/6919)#$#1*61=/>1*)#D13/>1LY;;1')691
you that later.
1. 8@#/1*)#1#"#$%&'#1=;#1PC$3@)&%1?**$&E7*#'I.9"TI1L/1*)&'1=;#V1+6719&;;1=/>1'#.#$3;1'&D@;#1

shapes.

Applying a Fill of None
1. Move the cursor over one of the objects 
3/>1%;&%G1*61'#;#%*1&*I12)3/4#1*)#1=;;1*61
None by dropping down the menu to the 
right of the paint bucket icon on the 
Attributes palette. The object will just show 
an edge. Objects underneath this object 
would still be visible.
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Applying a Solid Color Fill
1. Select another object. Use the attributes 
@3;#**#1*61%)3/4#1*)#1=;;1%6;6$1F$6D19)&*#1
to another color of your choice. In this 
case I’ve chosen a muted brown from the 
Benjamin Moore Ready Mixed color 
palette which I added in the “Setting up 
Your Drawing Board” chapter.

Applying a Pattern
1. 2)66'#13/6*)#$16Ea#%*13/>1=;;1&*19&*)131

pattern. Patterns are repeated across the 
object and there is a range of patterns 
from which to choose. You can also 
change the foreground and background 
color of the pattern. Bitmaps will not 
change scale if you decide at a later stage 
to change the scale of your drawing. A 
hatch is a better option if you want 
patterns to be scalable.

Applying Hatches
1. -#;#%*13/6*)#$16Ea#%*13/>1=;;1&*19&*)131)3*%)I1H#%*6$96$G'19&;;137*6D3*&%3;;+1'#;#%*1*)#1=$'*1

hatch from the default hatch list (Aluminum). However, if you click on the palette where 
Aluminum is showing, you can choose a different hatch—try one of the brick hatches. 
Depending on how the good people at Nemetschek have created these hatches, some of 
them are “real world” sizes and will show their actual size at the scale of the drawing. If you 
change the scale, your hatch will scale with it. Hatching via the Attributes palette is called 
applying an “Associative Hatch”. Move one of the objects that you’ve hatched, and you’ll 
see that the hatch moves with it.

2. However, if you take a look at the way the hatch has been applied, you will see that it has 
hatched from the center of the object outward. In my case, this means the bottom course 
of brickwork needs some very careful cutting and probably won’t be very stable! So, for a 
brick hatch, you may want to have more precise control over how the hatch is placed. 
-#;#%*13/6*)#$16Ea#%*1]6/#1*)3*1>6#'/Y*1+#*1)3.#131=;;^I1A$6D1*)#1U6>&F+1D#/7V1'#;#%*1*)#1
Hatch command. Choose the same Brick hatch that you used before. Notice that the 
cursor has changed to a paint bucket—it’s loaded with your choice of hatch and ready to 
apply it to the object. Position the cursor at the bottom left corner of the square and click. 
Move the cursor to the bottom right of the square and click again. Notice that the hatch 
now starts at the bottom of the shape with a complete course of brickwork.
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!"#$%&A/3-&70$1#$-&2/1#+-&84"24&1-&1&G4"4?1--"731#3,$H&/1#7/@&'4&6=134&I45=3-/9&#/$&/1#7/&
created will be independent of the object you’ve hatched and is essentially a group of lines 
#/1#&;#&)"*0&-/16$@&D*#&:",345&)"*0&-/16$&23==&4"#&:",$&#/$&/1#7/&*4=$--&)"*&;0-#&-$=$7#&
#/$&"BJ$7#&K!>&#/$&/1#7/9&#/$4&50"*6&#/$:&,31&#/$&L".3()&:$4*&M0"*6&7"::14.@

Left image shows hatch applied with the Attributes palette. The right image shows the hatch applied using the Hatch 
command.

Applying Gradients – Color Blends
C$3>&#/*'1=;;1*)#16Ea#%*19&*)1314$3>73*#>1E;#/>16F16/#1%6;6$1&/*613/6*)#$I1U3/+13$#1@$6.&>#>1
for you but you can create your own—we’ll look at this later. Now you are starting to see that 
you can render your drawings in a similar way to hand-drawing.
1. -#;#%*13/6*)#$16Ea#%*1F$6D1*)#1C$3@)&%1?**$&E7*#'I.9"1=;#I1A$6D1*)#1?**$&E7*#'1@3;#**#V1

choose Gradient. Beneath the word gradient, you will now see the top of the default list of 
gradients has been chosen for you. Click on this to change to a different gradient.

2. Notice that the gradient has applied the color in vertical bands from the left of the shape to 
the right. This is called a linear placement as the color is in vertical lines. Click on the Fill 
Gradient settings button on the Attributes palette.

3. Notice that you can change the gradient 
here if you wish, and change the style of 
gradient. Choose Foliage Light Green. 
Change the gradient type to Radial and 
press the Preview button. Notice that the 
gradient colors now bend around a central 
point and that this central point is on the 
left of the object. Change the X offset 
.3;7#1*61hiRDD1]hJT^
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Applying a “Photorealistic” Image Fill
?/1LD34#1A&;;1=;;'13/16Ea#%*19&*)131E&*D3@@#>1&D34#I1()#1LD34#1-#**&/4'1>&3;641E6"1@$6.&>#'1
options for applying them.
1. -#;#%*13/6*)#$16Ea#%*1F$6D1*)#1C$3@)&%1?**$&E7*#'I.9"1=;#I1A$6D1*)#1?**$&E7*#'1@3;#**#1
'#;#%*131=;;1*+@#16F1LD34#I1()#/1F$6D1*)#1LD34#1'#;#%*&6/1E#;69V1%)66'#1B$&%G1:3.#$1Z#>1
IF. This will be available in the Default Image list.

2. Now, as you did with the gradient, change 
the settings of the image using the Fill 
Settings button on the Attributes palette 
]#/'7$&/41=$'*1*)3*1*)#16Ea#%*1+67Y.#1a7'*1
=;;#>1&'1'*&;;1'#;#%*#>^I12)3/4#1*)#1$6*3*&6/1
of the image to 45º and then click OK.

Changing Pen Settings
()#1@#/1?**$&E7*#'1%)6&%#'13$#1'&D&;3$1*61*)6'#13.3&;3E;#1F6$1=;;'1&/1*)3*1+671%3/1%)66'#1F$6D1
solid, pattern, or dashed settings. The color options are also the same. In this exercise, you’ll 
learn how to change the line style, the line thickness, color and end markers.
1. -#;#%*13/6*)#$16Ea#%*1F$6D1*)#1C$3@)&%1?**$&E7*#'I.9"1=;#I12;&%G16/1*)#1Q&/#1-*+;#1E6"16/1

the Attributes palette and choose a thicker pen, then choose a dashed line style.
2. -#;#%*1*)#1)6$&O6/*3;1;&/#13*1*)#1E6**6D16F1*)#1C$3@)&%1?**$&E7*#'I.9"1=;#I18/1*)#1?**$&E7*#'1

palette, click on both the Line Start Marker Toggle and the Line End Marker Toggle buttons. 
This switches on end markers for both ends of the line. You can now select the end 
markers you want by choosing from the Line Startpoint Style and Line Endpoint Style 
drop-down lists. You can choose different end markers for each end of the line.

Note: If you want to refer to line thickness in a measurement other than millimeters. Line 
styles can be referred to by their size in points, or mils, or millimeters. To change the way 
Vectorworks describes your line style, go to the Tools menu, select Options and then Line 
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Thickness. On this palette, you can also choose which line styles are shown in which order 
on your Attributes palette.

Changing an Object’s Opacity
With the opacity setting, you can adjust the transparency of individual 2D objects with the 
Attributes palette, or by using class attributes.
1. At the bottom right of the Graphic 
?**$&E7*#'I.9"1=;#V1*)#$#1&'1314$##/1%&$%;#1
overlapping a rectangle that has a 
)3*%)#>1=;;I1-#;#%*1*)#14$##/1%&$%;#I

2. On the Attributes palette, click on the 
button that says Opacity 100%. Change 
the value to 80% either by typing the new 
value or by moving the slider button. Click 
Set Opacity.

!"#$%&K==&"(&#/$&1B",$&:$#/".-&166=)&#"&N>&"BJ$7#-&"4=)@&O4=$--&)"*&/1,$&P$4.$02"08-9&)"*&
23==&"4=)&B$&1B=$&#"&166=)&-"=3.&;==&7"="0-&#"&Q>&"BJ$7#-@&C"2$,$09&R$7#"02"08-&/1-&-":$&
50$1#&#""=-&("0&70$1#345&"BJ$7#-&#/1#&B$/1,$&B"#/&1-&N>&14.&Q>&"BJ$7#-S71==$.&C)B03.-@&
You’ll learn more about these as you move through the book. They make adding hard 
=14.-716345S1-&2$==&1-&6=14#3459&14.&"#/$0&510.$4&-#0*7#*0$-S#"&)"*0&.$-354&$1-)@

Changing the Default Values on the Attributes Palette
Now that you know how to change the values on the Attributes palette and apply the different 
options to individual objects, we’re going to look at the palette itself and see how you can 
@#$D3/#/*;+1%)3/4#1*)#1>#F37;*1.3;7#'1]9)&*#1'6;&>1=;;V1E;3%G1'6;&>1@#/19&*)1IRiDD1*)&%G/#''^I1
As I mentioned above, I have seen occasions where a .05 line will not print on some printers. 
Therefore, it’s my recommendation that you change this to something higher. When drawing 
by hand, you probably used a .18 mm pen or maybe a .13mm if you were less clumsy than I 
am.
1. Make sure you have nothing selected (click on a blank space on the drawing area.) Verify 

nothing is selected by looking at the Object Info palette which should say, “No Selection”. 
It’s important that nothing is selected; otherwise your changes will apply to the selected 
object.

2. Change the Attributes palette Pen Line Style to a solid black line with .18mm thickness (or 
.13mm if you prefer).

3. On the bottom of the palette, you will see a small arrow. Click on the arrow to reveal the 
menu.

4. 2)66'#1-#*1<#F37;*1?**$&E7*#'I156719&;;1/6916/;+14#*131IRi1DD1;&/#1&F1+671'@#%&=%3;;+193/*1
it.
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5. From the File menu, choose Save As and 
4&.#1*)#1=;#131/3D#1PU+1C$3@)&%1
Attributes” if you wish. This will leave the 
original exercise clean should you decide 
*61$7/1*)$674)1&*1343&/I12;6'#1*)#1=;#17'&/41
Close from the File menu.

Adding a “Stipple” Effect to an Object
The graphics we’ve looked at so far apply 
quite uniform effects to objects. Hatches are 
a predetermined series of regular lines, for 
example. But as a garden and landscape designer, you will often want to replicate the effect of 
dotting your pencil or pen over an area to denote long grass.
This exercise will show you how to use the stipple tool to create such areas. You create a 
'*&@@;#1E+17'&/4131'@#%&=%1*66;c1*)#1-*&@@;#1*66;c9)&%)1+67Y;;1=/>1&/1*)#1<&D'13/>1d6*#'1
palette.
1. 8@#/1*)#1=;#1C$3@)&%1?**$&E7*#'c-*&@@;&/4I.9"I
2. Click on the Stipple tool in the Dims/Notes palette and then note the options available on 

the Tool Bar: They are the same as those for the Polyline tool. Choose the corner vertices. 
()#/1%;&%G16/1*)#1:$#F#$#/%#'1E7**6/1]*)#16/#19&*)1*)#19$#/%)13/>1@#/%&;^1*61>#=/#1+67$1
stipple choices.

3. Your stipple can contain a mixture of up to two shapes, which will be generated at random 
within parameters that you specify. For this stipple, we are going to use just one shape. 
Leave the default settings in place with the following exceptions:
!" #$%&'"()*+,-)$,-01()&'1D#3/'1*)3*13/+1D#3'7$#D#/*'17'#>1*61>#=/#1*)#1'*&@@;#1

relate to real–world sizes (and the stipple will rescale if you change the scale of the 
drawing).

!" ./'+"01)22&+"3%$*"4'5+: Set a stipple width of 1000mm (3’). This will reduce the 
density of your stipple towards the middle of the area.

4. Trace over the edge of the Rectangle to apply your stipple, using the Point cue on the 
screen to help you draw with accuracy.

5. -3.#1*)#1=;#17'&/41*)#1-3.#1?'16@*&6/1F$6D1*)#1A&;#1D#/7I123;;1&*1 
My Graphics – Stipple.vwx and then close it using the Close option on the File menu.

Note:  You can further soften the effect of the stipples by using paler gray colors instead of the 
solid black shown here.
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P$7#145=$&23#/&-#366=$&166=3$.&",$0&#/$&#"69&#"5$#/$0&23#/&.31="5&B"T&#"&70$1#$&#/$&-1:$&-#366=$@

Adding Irregular Patterns to Objects Using the Tile Command
You’ve seen that you can hatch objects. Hatch patterns are regular patterns, made up of 
straight lines. These are great for paving where the pattern is regular. However, if you want to 
create a pattern that is less regular, you can use the Tile command. Vectorworks provides a 
series of “tiles” for you to use. You can create your own by creating new symbols.  You will 
learn how to do this later when learning about the Resource Browser.
1. 8@#/1*)#1=;#1C$3@)&%1?**$&E7*#'1,1(&;&/4I.9"I156719&;;1'##131$#%*3/4;#19&*)1314$3+14$3>&#/*1
=;;I156713$#1/69146&/41*613>>13/1&$$#47;3$1@3.&/41@3**#$/16.#$1*)#1*6@

2. Select the rectangle. From the Modify menu, select the Tile command.
3. From the drop down menu on the dialog 

box, select Granite – Large. Ensure that 
Clear Undo History is ticked. This will 
speed the process. (Tiling a large area 
can take your computer a long time as it 
requires a lot of thinking time!)

4. Click OK. The object will tile. Again, bear 
in mind this can take a while and could even be time to make a cup of tea if the area is 
large. This exercise step won’t allow you enough time for tea though!
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5. -3.#1*)#1=;#19&*)131/#91/3D#1'7%)13'1PU+1C$3@)&%'1,1(&;#'I.9"T13/>1%;6'#1&*17'&/412;6'#1
from the File menu.

How to get Vectorworks to Remember your Favorite Graphics
Earlier I told you that there were some things you probably weren’t feeling 100% convinced 
3E67*1+#*j12;3''#'13$#1@$6E3E;+16/#16F1*)6'#1*)&/4'I1L1)3.#1*61%6/F#''1*)3*19)#/1L1=$'*1$#3>1
the word “classes” when I evaluated Vectorworks, horrible memories of programming courses 
during my previous career sprang to mind. But classes are really not scary things at all. In 
fact, they are incredibly useful! If you’ve used desktop publishing systems before, or even 
7'#>1'*+;#'1&/1W6$>V1+67Y;;1=/>1*)#1%6/%#@*1&'1'&D&;3$I1LF1+671)3.#/Y*V1'*&;;1>6/Y*1@3/&%I12;3''#'1
are just named containers that hold graphic attributes. For example, you could create a class 
%3;;#>1>#%G&/4V13/>19&*)&/1*)3*1%;3''V1>#=/#1
the graphic attributes you want to apply to 
decking each time you draw it. You will learn 
much more about this in the chapter on 
Adding Hard Landscaping.
1. 8@#/1*)#1=;#1C$3@)&%1?**$&E7*#'1f'&/41

Classes.vwx.
2. On the Navigation palette, click on the 

left-most tab – Classes. Note that I have 
created a class here called Paving. Click 
on its name to highlight it and then click 
your right mouse button, choosing edit 
from the context menu.

3. d6*&%#1*)3*1*)#1%;3''1)3'131'6;&>14$3+1=;;1
set. Click OK to close the class.

4. Select the rectangle. Via the Object Info 
palette notice that the current class is 
“None”. Drop down the list to the right of 
the class name, to access other classes 
3.3&;3E;#1&/1*)&'1=;#I12)66'#1:3.&/4I

5. Note that the rectangle has now inherited 
the graphic properties of the paving class.

6. Using the same technique, select the 
circle and change its class to Tree 
Canopy.

7. -3.#131%6@+16F1*)#1=;#1&F1+6719&')V1%3;;&/41
it My Graphics Classes.vwx and close it.
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!"#$%&M016/37-&-*7/&1-&U#366=$-&10$&/14.=$.&-=35/#=)&.3(($0$4#=)@&A/$)&714+#&=3,$&34&7=1--$-&V&B*#&
#/$)&714&B$&-#"0$.&1-&GP$-"*07$-H@&U$$&#/$&7/16#$0&"4&U$##345&*6&W"*0&P$-"*07$&D0"2-$0&
for more information.
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